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NEW QUESTION 1
A Vault Administrator team member can log in to CyberArk, but for some reason, is not given Vault Admin rights.
Where can you check to verify that the Vault Admins directory mapping points to the correct AD group?

A. PVWA > User Provisioning > LDAP Integration > Mapping Criteria
B. PVWA > User Provisioning > LDAP Integration > Map Name
C. PVWA > Administration > LDAP Integration > Mappings
D. PVWA > Administration > LDAP Integration > AD Groups

Answer: C

Explanation: 
 The directory mappings are the rules that define how users and groups from an external directory, such as Active Directory (AD), are mapped to roles and
authorizations in CyberArk. To verify that the Vault Admins directory mapping points to the correct AD group, you need to check the Mappings page in the PVWA.
This page displays the list of existing directory mappings in the Vault and their properties, such as mapping name, LDAP branch, domain groups, and mapping
authorizations. You can edit or delete a directory mapping from this page, or create a new one using the Create Directory Mapping
button. References: Directory Maps, Create directory mapping, Get directory mapping list

NEW QUESTION 2
Which accounts can be selected for use in the Windows discovery process? (Choose two.)

A. an account stored in the Vault
B. an account specified by the user
C. the Vault Administrator
D. any user with Auditor membership
E. the PasswordManager user

Answer: AB

Explanation: 
 During the Windows discovery process in CyberArk Defender PAM, accounts that can be selected for use include an account that is already stored in the Vault
and an account that is specified by the user. The discovery process scans predefined machines for new and modified accounts and their dependencies. After the
scan, accounts that should be onboarded into the Vault for secure and automatic management are identified12. References: The information provided is based on
general knowledge of CyberArk PAM best practices and the account discovery process as outlined in CyberArk’s official documentation1

NEW QUESTION 3
Which Automatic Remediation is configurable for a PTA detection of a “Suspected Credential Theft”?

A. Add to Pending
B. Rotate Credentials
C. Reconcile Credentials
D. Disable Account

Answer: B

Explanation: 
 For a Privileged Threat Analytics (PTA) detection of a “Suspected Credential Theft,” the automatic remediation that can be configured is Rotate Credentials. This
remediation action is designed to automatically initiate password changes when PTA identifies a suspected credential threat, such as a credential theft event. By
rotating the credentials, CyberArk ensures that the potentially compromised credentials are changed, thus mitigating the risk of unauthorized access1.
References:
? CyberArk’s official documentation on configuring PTA remediations, which includes information on automatic password rotation for suspected credential
threats2.
? Additional details on the remediation actions that can be configured for different types of PTA detections, including Suspected Credential Theft1.

NEW QUESTION 4
Which of the Following can be configured in the Master Poky? Choose all that apply.

A. Dual Control
B. One Time Passwords
C. Exclusive Passwords
D. Password Reconciliation
E. Ticketing Integration
F. Required Properties
G. Custom Connection Components
H. Password Aging Rules

Answer: ABCH

Explanation: 
 The Master Policy is a centralized overview of the security and compliance policy of privileged accounts in the organization. It allows the administrator to configure
compliance driven rules that are defined as the baseline for the enterprise. The Master Policy includes the following main concepts1:
? Basic policy rules: These rules allow the administrator to define specific aspects of privileged account management, such as privileged access workflows,
password management, session monitoring and auditing.
? Advanced policy rules: Some basic policy rules have related advanced settings that provide more granular control over the policy enforcement.
? Exceptions: These are policy rules that differ from the overall Master Policy for a specific scope of accounts, such as accounts associated with a specific
platform.
The Master Policy rules are divided into four sections2:
? Privileged Access Workflows: These rules define how the organization manages access to privileged accounts, such as requiring dual control, one-time
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passwords, exclusive passwords, transparent connections, reason for access, etc.
? Password Management: These rules determine how passwords are managed, such as requiring password change, password verification, password
reconciliation, ticketing integration, required properties, custom connection components, etc.
? Session Management: These rules determine whether or not privileged sessions are recorded and how they are monitored, such as requiring session isolation,
session recording, session audit, etc.
? Audit: This rule determines how Safe audits are retained, such as specifying the audit retention period.
Based on the above information, the following options can be configured in the Master Policy:
? A. Dual Control: This is a basic policy rule in the Privileged Access Workflows
section that determines whether users need to get approval from authorized users before accessing a privileged account2.
? B. One Time Passwords: This is a basic policy rule in the Privileged Access
Workflows section that determines whether users can only use a password once before it is changed2.
? C. Exclusive Passwords: This is a basic policy rule in the Privileged Access
Workflows section that determines whether users need to check out a password and prevent other users from accessing it until it is checked in2.
? H. Password Aging Rules: This is a basic policy rule in the Password Management
section that determines how often passwords need to be changed2. The following options cannot be configured in the Master Policy:
? D. Password Reconciliation: This is not a policy rule, but a process that restores
the password of a privileged account to the value that is stored in the Vault, in case it is changed or out of sync3.
? E. Ticketing Integration: This is not a policy rule, but a feature that enables the
integration of the Vault with external ticketing systems, such as ServiceNow, Jira, etc.
? F. Required Properties: This is not a policy rule, but a platform setting that determines which properties are mandatory for adding accounts to a platform.
? G. Custom Connection Components: This is not a policy rule, but a platform setting that determines which connection components are used to connect to target
systems, such as PVWA, PSM, PSMP, etc.
References:
? 1: The Master Policy
? 2: Master Policy Rules
? 3: Password Reconciliation
? : Ticketing Integration
? : Required Properties
? : Custom Connection Components

NEW QUESTION 5
Which parameters can be used to harden the Credential Files (CredFiles) while using CreateCredFile Utility? (Choose three.)

A. Operating System Username
B. Host IP Address
C. Client Hostname
D. Operating System Type (Linux/Windows/HP-UX)
E. Vault IP Address
F. Time Frame

Answer: BCE

Explanation: 
 When using the CreateCredFile Utility to harden Credential Files (CredFiles), it is important to include parameters that enhance security. The Host IP Address,
Client Hostname, and Vault IP Address are parameters that can be used to specify the environment in which the CredFile is valid, thereby restricting its use to
specific machines or networks1. This helps prevent unauthorized access to the CredFile and ensures that it is only used in the intended context.
References:
? CyberArk’s official documentation on the CreateCredFile utility provides insights into the security mechanisms used to protect credential files, including the use
of environmental key materials such as application-based, machine-based, and component-based materials1.
? For a deeper understanding of how to secure Credential Files and the use of the CreateCredFile Utility, refer to the CyberArk Defender PAM course materials
and study guide2.

NEW QUESTION 6
Which of the following Privileged Session Management (PSM) solutions support live monitoring of active sessions?

A. PSM (i.e., launching connections by clicking on the connect button in the Password Vault Web Access (PVWA)
B. PSM for Windows (previously known as RDP Proxy)
C. PSM for SSH (previously known as PSM-SSH Proxy)
D. All of the above

Answer: D

Explanation: 
 According to the web search results, all of the Privileged Session Management (PSM) solutions support live monitoring of active sessions. PSM, PSM for
Windows, and PSM for SSH enable authorized users to monitor active sessions from their workstation and take part in controlling these sessions. Users can also
suspend or terminate active sessions based on their group assignment. By default, active session monitoring is enabled at system level for all authorized users,
and can be disabled at platform level. Active session monitoring can also be disabled at system level, but when it is disabled, it cannot be enabled at platform level.
PSM can automatically suspend or terminate sessions when notified by PTA or a third party threat analytics tool1. Authorized users monitor or terminate an active
session using the same connection method (RDP file or HTML5 Gateway) as the end user

NEW QUESTION 7
The vault supports Role Based Access Control.

A. TRUE
B. FALSE

Answer: A

Explanation: 
The vault supports Role Based Access Control (RBAC), which is a method of granting access to resources based on the roles of users or groups. RBAC enables
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the administrator to define roles that represent different functions or responsibilities in the organization, and assign permissions to those roles according to the
principle of least privilege. Users or groups can then be assigned to one or more roles, and inherit the permissions of those roles. RBAC simplifies the
management of access control by reducing the complexity and redundancy of assigning permissions to individual users or groups. RBAC also enhances security
and compliance by ensuring that users or groups only have the minimum level of access required to perform their tasks1.
References:
? 1: Role Based Access Control

NEW QUESTION 8
When the CPM connects to a database, which interface is most commonly used?

A. Kerberos
B. ODBC
C. VBScript
D. Sybase

Answer: B

Explanation: 
 The Central Policy Manager (CPM) in CyberArk most commonly uses the ODBC (Open Database Connectivity) interface when connecting to a database. ODBC
is a standard API for accessing database management systems (DBMS). The CPM supports remote password management on all databases that support ODBC
connections, and the machine running the CPM must support ODBC, version 2.7 and higher1. References:
? CyberArk Docs: Databases that support ODBC connections1

NEW QUESTION 9
What is the purpose of the PrivateArk Database service?

A. Communicates with components
B. Sends email alerts from the Vault
C. Executes password changes
D. Maintains Vault metadata

Answer: D

Explanation: 
 The purpose of the PrivateArk Database service is to maintain the Vault metadata, which includes the information about the Safes, accounts, policies, users,
groups, and audit records that are stored in the Vault. The PrivateArk Database service is a Windows service that manages the database files that contain the
Vault data. The PrivateArk Database service is responsible for creating, updating, deleting, and backing up the database files, as well as performing encryption
and compression operations on the data1. The PrivateArk Database service is installed automatically as part of the Vault server installation and can be configured
using the DBParm.ini file2.
The other options are not the purpose of the PrivateArk Database service, although they may be related to other services or components of the Vault. The
PrivateArk Server service is the service that communicates with the components, such as the PVWA, the CPM, the PSM, and the PTA, and handles the requests
from the clients and components3. The Event Notification Engine service is the service that sends email alerts from the Vault, based on predefined events and
recipients4. The Central Policy Manager component is the component that executes password changes, verifications, and reconciliations for the accounts that are
managed by the Vault. References:
? Server Components - CyberArk, section “The PrivateArk Server process (Dbmain)”
? DBParm.ini - CyberArk, section “Main parameters”
? Server Components - CyberArk, section “The PrivateArk Server process (Dbmain)”
? Event Notification Engine - CyberArk, section “Event Notification Engine”
? [Change Passwords - CyberArk], section “Change Passwords”

NEW QUESTION 10
As long as you are a member of the Vault Admins group, you can grant any permission on any safe that you have access to.

A. TRUE
B. FALSE

Answer: B

Explanation: 
 Being a member of the Vault Admins group does not automatically grant you any permission on any safe that you have access to. The Vault Admins group is a
predefined group that is created during the installation or upgrade of the vault. This group has the Vault Admin authorization, which allows its members to perform
administrative tasks on the vault, such as managing users, groups, platforms, policies, and safes1. However, this authorization does not include any safe member
authorizations, such as View, Retrieve, Use, or Manage Safe2. Therefore, to grant any permission on a safe, you need to be added as a safe member with the
appropriate authorizations, either directly or through another group. The Vault Admins group can be added to safes with all safe member authorizations, but this is
not done automatically for all safes. By default, this group is only added to a number of system safes, such as the Password Manager Safe, the PVWAConfig Safe,
and the Notification Methods Safe3. For other safes, the Vault Admins group can be added manually by the safe owner or another user with the Manage Safe
authorization4. References:
? 1: Predefined users and groups, Predefined groups subsection
? 2: [CyberArk Privileged Access Security Implementation Guide], Chapter 3: Managing Safes, Section: Safe Authorizations, Table 2-1: Safe Authorizations
? 3: What default groups can be automatically added to Safes when they are created?
? 4: [CyberArk Privileged Access Security Administration Guide], Chapter 3: Managing Safes, Section: Adding Safe Members

NEW QUESTION 10
As long as you are a member of the Vault Admins group you can grant any permission on any safe.

A. TRUE
B. FALSE

Answer: B
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Explanation: 
 The Vault Admins group is a predefined group that is automatically created during the installation or upgrade of the Vault. This group has all possible permissions
in the Vault, and can create and manage other users, groups, platforms, policies, safes, and accounts. However, this group is not automatically added to every
safe in the Vault, but only to some system safes that are used for administrative purposes. Therefore, being a member of the Vault Admins group does not
guarantee that you can grant any permission on any safe, unless you are also a member or an owner of that safe. To grant permissions on a safe, you need to
have the Authorize safe members authorization on that safe, which allows you to add or remove users or groups as safe members, and assign or revoke their
authorizations. Alternatively, you can use the Administrator user, which is a predefined user that is a member of the Vault Admins group, and has all possible
permissions on any safe in the Vault. References:
? Predefined users and groups
? Safe member authorizations

NEW QUESTION 11
A logon account can be specified in the platform settings.

A. True
B. False

Answer: A

Explanation: 
 A logon account can be specified in the platform settings of CyberArk, a security software that manages privileged accounts and credentials. According to the
CyberArk documentation1, "In the Account Details window, in the CPM pane, in the accounts section, you can associate either a logon account or a reconciliation
account. If a default logon account has been configured for the platform that manages this account, that account is listed. You can associate another logon account
or leave the default account as it is."1 A logon account is an account that is used to log on to a target system and perform password management operations on
other accounts. A reconciliation account is an account that is used to restore access to a target system when the logon account fails.

NEW QUESTION 13
Which usage can be added as a service account platform?

A. Kerberos Tokens
B. IIS Application Pools
C. PowerShell Libraries
D. Loosely Connected Devices

Answer: B

Explanation: 
 A service account platform is a type of platform that defines how CyberArk manages passwords for service accounts, which are accounts that run applications or
services on remote machines. A usage is a configuration that allows CyberArk to manage passwords for files, such as XML or INI files, that are stored on remote
machines. A usage is associated with a parent account, which is the account that has access to the file. A usage can be added as a service account platform if the
file contains the password of a service account. For example, IIS Application Pools is a usage that can be added as a service account platform, because it
manages the passwords of the application pools that run on IIS servers. The other options, Kerberos Tokens, PowerShell Libraries, and Loosely Connected
Devices, are not usages that can be added as service account platforms, because they do not manage passwords for service accounts. References: Usages,
Service Account Platforms

NEW QUESTION 16
Which statement about the Master Policy best describes the differences between one-time password and exclusive access functionality?

A. Exclusive access means that only a specific group of users may use the accoun
B. After an account on a one-time password platform is used, the account is deleted from the safe automatically.
C. Exclusive access locks the account indefinitel
D. One-time password can be used replace invalid account passwords.
E. Exclusive access is enabled by default in the Master Polic
F. One-time password should only be enabled for emergencies.
G. Exclusive access allows only one person to check-out an account at a tim
H. One-time password schedules an account for a password change after the MinValidityPeriod period expires.

Answer: D

Explanation: 
 The Master Policy in CyberArk defines the behavior of one-time passwords and exclusive accessExclusive access ensures that only one user can check out an
account at any given time, effectively locking the account during its use to prevent simultaneous access1. On the other hand, one-time password functionality is
designed to change the account’s password after it is used, based on a timer set by the MinValidityPeriod parameter in the policy file. This means that once the
password is checked out and the timer expires, the Central Policy Manager (CPM) will change the password2. These settings are often used together to maintain
accountability and security for the usage of shared privileged accounts. References:
? CyberArk Docs: One-time passwords and exclusive accounts1
? CyberArk Knowledge Article: CPM: What is the difference between “One Time” and “Exclusive” passwords?2

NEW QUESTION 20
What does the minvalidity parameter on a platform policy determine?

A. time between a password retrieval and the account becoming eligible for a password change
B. timeout for users signed into the PVWA as configured in the global settings
C. minimum amount of time that Just in Time access is valid
D. time in minutes before an empty safe will be automatically deleted

Answer: A

Explanation: 
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 The minvalidity parameter on a platform policy in CyberArk determines the minimum amount of time that must pass between the retrieval of a password and when
the account becomes eligible for a password change. This parameter ensures that a user has a guaranteed period to use the password before it is changed again,
providing stability and predictability in password management1. References: The information provided is based on general knowledge of CyberArk PAM best
practices and the functionality of the minvalidity parameter as outlined in CyberArk’s official documentation

NEW QUESTION 23
You are concerned about the Windows Domain password changes occurring during business hours.
Which settings must be updated to ensure passwords are only rotated outside of business hours?

A. In the platform policy - Automatic Password Management > Password Change > ToHour & FromHour
B. in the Master Policy Account Change Window > ToHour & From Hour
C. Administration Settings - CPM Settings > ToHour & FromHour
D. On each individual account - Edit > Advanced > ToHour & FromHour

Answer: B

Explanation: 
 To ensure that Windows Domain password changes occur outside of business hours, the settings that must be updated are found in the Master Policy under the
Account Change Window section. Here, you can specify the ToHour and FromHour to define the time frame outside of which the passwords should be rotated.
This setting allows you to control when password changes can occur, ensuring
that they do not interfere with business operations by taking place during non-business hours1.
References:
? CyberArk Docs - Set password policies

NEW QUESTION 28
You are onboarding 5,000 UNIX root accounts for rotation by the CPM. You discover that the CPM is unable to log in directly with the root account and will need to
use a secondary account.
How should this be configured to allow for password management using least privilege?

A. Configure each CPM to use the correct logon account.
B. Configure each CPM to use the correct reconcile account.
C. Configure the UNIX platform to use the correct logon account.
D. Configure the UNIX platform to use the correct reconcile account.

Answer: C

Explanation: 
 When onboarding a large number of UNIX root accounts for password rotation by the Central Policy Manager (CPM), and the CPM cannot log in directly with the
root account, it is necessary to configure the UNIX platform to use a secondary logon account that has the appropriate privileges. This secondary account should
have the minimum necessary permissions to perform password management tasks, adhering to the principle of least privilege1. By configuring the UNIX platform
with the correct logon account, the CPM can use this account to manage the root accounts securely and efficiently.
References:
? CyberArk’s official documentation on Least Privileges and Privileged Access Manager provides guidance on configuring on-demand privileges for UNIX
environments, which includes setting up the correct logon account for tasks that require elevated privileges1.
? Additional information on managing UNIX and Linux accounts, including the configuration of logon and reconcile accounts, can be found in the Unix plugin
documentation for CyberArk

NEW QUESTION 33
DRAG DROP
Match each key to its recommended storage location.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
? The recommended storage locations for each key are as follows:
? Recovery Private Key: It is recommended to store the Recovery Private Key on the Vault Server Disk Drive. This is because the Recovery Private Key is used to
decrypt the data stored in the Vault.
? Recovery Public Key: It is recommended to store the Recovery Public Key in a Hardware Security Module. This is because the Recovery Public Key is used to
encrypt the data stored in the Vault.
? Server Key: It is recommended to store the Server Key in a Physical Safe. This is because the Server Key is used to open the Vault, much like the key of a
physical Vault. The key is required to start the Vault, after which the Server Key can be removed until the Server is restarted. When the Vault is stopped, the
information stored in the Vault is completely inaccessible without that key.
? SSH Keys: It is recommended to store the SSH Keys in the Vault. This is because the SSH Keys are used to connect to remote machines using the SSH
protocol. The Vault can manage the passwords and sessions for the SSH Keys and provide secure access to the target systems.
References: Server keys - CyberArk, Cyberark Key Storage Plugin (Enterprise) - Rundeck
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NEW QUESTION 35
Which dependent accounts does the CPM support out-of-the-box? (Choose three.)

A. Solaris Configuration file
B. Windows Services
C. Windows Scheduled
D. Windows DCOM Applications
E. Windows Registry
F. Key Tab file

Answer: BCE

Explanation: 
 Dependent accounts are accounts that represent resources such as Windows Services, Windows Scheduled Tasks, and others, which are accessed from a target
machine and require the same credentials as the target machine. The CyberArk Privileged Account Security Solution’s Central Policy Manager (CPM) supports
out-of-the- box dependent accounts for Windows Services, Windows Scheduled Tasks, and Windows Registry. When changing a password, the CPM
synchronizes the target account password with all other occurrences of that password in any related dependent accounts. This ensures that all dependent
accounts are updated simultaneously to maintain security and functionality12. References:
? CyberArk Docs: Manage dependent accounts1
? CyberArk Docs: Supported dependent accounts

NEW QUESTION 40
It is possible to restrict the time of day, or day of week that a [b]verify[/b] process can occur

A. TRUE
B. FALSE

Answer: A

Explanation: 
 It is possible to restrict the time of day, or day of week that a verify process can occur by using the Verify Time Window parameter in thePlatform Management
page. This parameter allows the administrator to define a time window for each platform, during which the verify process can be performed. The verify process will
not run outside of this time window, unless it is manually initiated by the administrator. This feature can help reduce the load on the target systems and the network
during peak hours. References:
? [Defender PAM Course], Module 4: Managing Accounts, Lesson 2: Account Verification, Slide 8: Verify Time Window
? [Defender PAM Documentation], Version 12.3, Administration Guide, Chapter 4: Managing Platforms, Section: Verify Time Window

NEW QUESTION 44
You need to recover an account localadmin02 for target server 10.0.123.73 stored in Safe Team1.
What do you need to recover and decrypt the object? (Choose three.)

A. Recovery Private Key
B. Recover.exe
C. Vault data
D. Recovery Public Key
E. Server Key
F. Master Password

Answer: ABC

Explanation: 
 To recover and decrypt an account that is stored in a Safe, you need the following items:
? Recovery Private Key: This is a key that is used to decrypt the data stored in the Vault. It is located on the Master CD, which is a physical CD that contains the
Private Recovery Key, a file named RecPrv.key.
? Recover.exe: This is a utility that is used to recover information from a Safe’s external files in case of loss or corruption of that Safe. The files are decrypted and
saved as readable files. The utility can be run from the command line or the graphical user interface.
? Vault data: This is the data that is stored in the Vault, such as accounts, safes, platforms, policies, users, groups, and audit records. The Vault data is encrypted
using the Recovery Public Key, which is a key that is used to encrypt the data stored in the Vault. The Vault data can be recovered from the Vault server disk drive
or from a backup file.
References: Recover, Server keys, Export Vault Information

NEW QUESTION 49
Which of these accounts onboarding methods is considered proactive?

A. Accounts Discovery
B. Detecting accounts with PTA
C. A Rest API integration with account provisioning software
D. A DNA scan

Answer: C

Explanation: 
 A Rest API integration with account provisioning software is considered a proactive account onboarding method, because it enables the automatic creation and
management of accounts in the Vault as soon as they are provisioned in the target systems. This way, the accounts are secured from the start and do not need to
be discovered or onboarded manually later. A Rest API integration with account provisioning software can be achieved by using the CyberArk Accounts Feed
REST API, which allows external applications to send account information to the Vault1.
The other options are not proactive account onboarding methods, because they rely on the discovery of existing accounts that may have been exposed or
compromised before being onboarded to the Vault. Accounts Discovery is a feature that enables the Vault to scan target systems and identify privileged accounts
that are not managed by the Vault2. Detecting accounts with PTA is a feature that enables the Privileged Threat Analytics (PTA) component to detect and alert on
suspicious account activities and credential thefts3. A DNA scan is a feature that enables the Discovery and Audit (DNA) tool to scan Windows and Unix machines
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and generate a report on the privileged accounts and vulnerabilities found4.
References:
? CyberArk Accounts Feed REST API - CyberArk, section “CyberArk Accounts Feed REST API”
? Accounts Discovery - CyberArk, section “Accounts Discovery”
? Detect and Respond to Privileged Account Threats - CyberArk, section “Detect and Respond to Privileged Account Threats”
? CyberArk DNA - CyberArk, section “CyberArk DNA”

NEW QUESTION 51
To ensure all sessions are being recorded, a CyberArk administrator goes to the master policy and makes configuration changes.
Which configuration is correct?

A. Require privileged session monitoring and isolation = inactive; Record and save session activity = active.
B. Require privileged session monitoring and isolation = inactive; Record and save session activity = inactive.
C. Require privileged session monitoring and isolation = active; Record and save session activity = active.
D. Require privileged session monitoring and isolation = active; Record and save session activity = inactive.

Answer: C

Explanation: 
 This configuration ensures that privileged sessions are monitored and isolated, and all session activities are recorded and saved for future reference 1.

NEW QUESTION 56
Which user(s) can access all passwords in the Vault?

A. Administrator
B. Any member of Vault administrators
C. Any member of auditors
D. Master

Answer: D

Explanation: 
 According to the CyberArk Defender PAM documentation1, the Master user is the only user that can access all passwords in the Vault. The Master user is a
special user that is created during the initial installation of the Vault and has full permissions on all Safes and accounts in the Vault. The Master user can also
perform administrative tasks, such as backup and restore the Vault, change the Vault license, and manage the recovery key. The Master user is the only user that
can log on to the Vault in case of a disaster using the recovery key. The Master user’s password is not stored in the Vault and cannot be changed or retrieved by
any other user.
The Administrator user is a predefined user that is created during the initial installation of the Vault and has the Vault Admin authorization. The Administrator user
can perform administrative tasks, such as create and manage users and groups, define platforms and policies, and monitor Vault activity. However, the
Administrator user cannot access any passwords in the Vault unless they are explicitly added as a member of a Safe that contains the passwords2.
The Vault administrators group is a predefined group that is created during the initial installation of the Vault and has the Vault Admin authorization. The members
of the Vault administrators group can perform the same administrative tasks as the Administrator user, but they cannot access any passwords in the Vault unless
they are explicitly added as a member of a Safe that contains the passwords2.
The auditors group is a predefined group that is created during the initial installation of the Vault and has the Audit Users authorization. The members of the
auditors group can view
and generate reports on the Vault activity, but they cannot access any passwords in the Vault unless they are explicitly added as a member of a Safe that contains
the passwords2. References:
? Master User - CyberArk
? Predefined users and groups - CyberArk

NEW QUESTION 59
DRAG DROP
Match the Status of Service on a DR Vault to what is displayed when it is operating normally in Replication mode.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
 CyberArk Hardened Windows Firewall -> Running PrivateArk Database -> Running
PrivateArk Server -> Stopped
CyberArk Vault Disaster Recovery -> Running CyberArk Event Notification Engine -> Stopped
? Comprehensive Explanation: A DR Vault is a Vault that acts as a standby replica of the Primary Vault and is ready to take its place when the Primary Vault is
unavailable. The DR Vault operates in Replication mode, which means it continuously replicates the data and metadata from the Primary Vault. In Replication
mode, the following services have the following status on the DR Vault:
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? Cyber-Ark Hardened Windows Firewall: This service provides firewall protection for the Vault server. It should be running on the DR Vault to ensure security.
? PrivateArk Database: This service manages the database that stores the metadata of the Vault. It should be stopped on the DR Vault, because the database is
not active in Replication mode. The database is only activated when the DR Vault switches to Production mode.
? PrivateArk Server: This service manages the Vault server and its communication with other components. It should be stopped on the DR Vault, because the
Vault server is not active in Replication mode. The Vault server is only activated when the DR Vault switches to Production mode.
? CyberArk Vault Disaster Recovery: This service manages the replication process between the Primary Vault and the DR Vault. It should be running on the DR
Vault to ensure data synchronization and readiness for failover.
? Cyber-Ark Event Notification Engine: This service manages the event notifications and alerts for the Vault. It should be stopped on the DR Vault, because the
event notifications are not relevant in Replication mode. The event notifications are only activated when the DR Vault switches to Production mode.
References: Primary-DR environment - CyberArk, Replicate the Primary Vault to the Satellite Vaults - CyberArk

NEW QUESTION 62
Which user is automatically added to all Safes and cannot be removed?

A. Auditor
B. Administrator
C. Master
D. Operator

Answer: C

Explanation: 
 The user that is automatically added to all Safes and cannot be removed is the Master user. The Master user is a predefined user that is created during the Vault
installation and has full permissions on all Safes and accounts. The Master user is the only user that can perform certain tasks, such as creating other predefined
users, managing the Vault configuration, and restoring the Vault from a backup. The Master user cannot be deleted or modified by any other user, and is always a
member of every Safe12. References:
? Predefined users and groups - CyberArk, section “Master”
? Safes and Safe members - CyberArk, section “Safe members overview”

NEW QUESTION 63
How does the Vault administrator apply a new license file?

A. Upload the license.xml file to the system Safe and restart the PrivateArk Server service
B. Upload the license.xml file to the system Safe
C. Upload the license.xml file to the Vault Internal Safe and restart the PrivateArk Server service
D. Upload the license.xml file to the Vault Internal Safe

Answer: C

Explanation: 
 According to the CyberArk Defender PAM documentation1, the Vault administrator can apply a new license file by uploading the license.xml file to the Vault
Internal Safe and restarting the PrivateArk Server service. The Vault Internal Safe is a special Safe that contains the Vault configuration files, including the license
file. The Vault administrator can access this Safe from the PrivateArk Client and replace the existing license file with the new one. After that, the Vault administrator
must restart the PrivateArk Server service for the changes to take effect. This procedure can be done either from the Vault machine or from a remote machine.
References:
? Manage the CyberArk License - CyberArk

NEW QUESTION 65
A user needs to view recorded sessions through the PVWA.
Without giving auditor access, which safes does a user need access to view PSM recordings? (Choose two.)

A. Recordings safe
B. Safe the account is in
C. System safe
D. PVWAConfiguration safe
E. VaultInternal safe

Answer: AB

Explanation: 
 To view recorded sessions through the PVWA without having auditor access, a user needs access to two specific safes: the Recordings safe and thesafe the
account is in. The Recordings safe is where the PSM session recordings are stored, and users need permission to access this safe to view the recordings.
Additionally, users need access to the safe where the account associated with the recorded session is stored, as this is where the session details and permissions
are managed12.
References:
? CyberArk Docs - Configure video and text recordings3
? CyberArk Community - Viewing PSM recorded sessions1

NEW QUESTION 68
An auditor needs to login to the PSM in order to live monitor an active session. Which user ID is used to establish the RDP connection to the PSM server?

A. PSMConnect
B. PSMMaster
C. PSMGwUser
D. PSMAdminConnect

Answer: A

Explanation: 
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 The PSMConnect user is a local user on the PSM server that is used to establish RDP connections to the PSM server. The PSMConnect user has the following
permissions: Log on locally, Log on as a batch job, and Allow log on through Remote Desktop Services. The PSMConnect user is also a member of the local group
PSMUsers, which has access to the PSM web console. The other user IDs are not used for RDP connections to the PSM server. The PSMMaster user is a local
user on the PSM server that is used to run the PSM services. The PSMGwUser user is a local user on the PSM server that is used to run the PSM Gateway
service. The PSMAdminConnect user is a local user on the PSM server that is used to connect to the PSM web console as an administrator. References:
Privileged Session Manager, Defender - PAM, PSM for Web Console, Connect through PSM for SSH

NEW QUESTION 71
What is the purpose of the HeadStartlnterval setting m a platform?

A. It determines how far in advance audit data is collected tor reports
B. It instructs the CPM to initiate the password change process X number of days before expiration.
C. It instructs the AIM Provider to ‘skip the cache' during the defined time period
D. It alerts users of upcoming password changes x number of days before expiration.

Answer: B

Explanation: 
 The purpose of the HeadStartInterval setting in a platform is to instruct the CPM to initiate the password change process X number of days before expiration. This
setting is used when the platform has the One Time Password feature enabled, which means that the passwords are changed every time they are retrieved by a
user. The HeadStartInterval setting defines the number of days before the password expires (according to the ExpirationPeriod parameter) that the CPM will start
the password change process. This gives the CPM enough time to change the password before it becomes invalid, and ensures that the user will always receive a
valid password when they request it1. The HeadStartInterval setting can be configured in the Platform Management settings for each platform that supports One
Time Passwords. The default value is 0, which means that the CPM will start the password change process on the same day as the password expiration date1.
The other options are not the purpose of the HeadStartInterval setting in a platform:
? A. It determines how far in advance audit data is collected for reports. This option
is not related to the HeadStartInterval setting, which does not affect the audit data collection or reporting. The audit data is collected by the Vault server and stored
in the Audit database, and the reports are generated by the PVWA or the PrivateArk Client based on the audit data2.
? C. It instructs the AIM Provider to ‘skip the cache’ during the defined time period.
This option is not related to the HeadStartInterval setting, which does not affect the AIM Provider or the cache mechanism. The AIM Provider is a component that
enables applications to securely retrieve credentials from the Vault without requiring human intervention. The cache mechanism is a feature that allows the AIM
Provider to store credentials locally for a limited time, in case of a temporary network failure or Vault unavailability3.
? D. It alerts users of upcoming password changes x number of days before
expiration. This option is not related to the HeadStartInterval setting, which does not alert users of anything. The HeadStartInterval setting only instructs the CPM
to initiate the password change process, not to notify the users. The users do not need to be aware of the password changes, as they are performed automatically
by the CPM and do not affect the user experience1. References:
? 1: Privileged Account Management, Min Validity Period subsection
? 2: Reports and Audits
? 3: Application Identity Manager

NEW QUESTION 76
Which certificate type do you need to configure the vault for LDAP over SSL?

A. the CA Certificate that signed the certificate used by the External Directory
B. a CA signed Certificate for the Vault server
C. a CA signed Certificate for the PVWA server
D. a self-signed Certificate for the Vault

Answer: A

Explanation: 
 To enable SSL-based encryption for LDAP integration, the Vault machine and the PVWA machine need to trust the certificate used by the External Directory. This
can be achieved by importing the CA Certificate that signed the certificate used by the External Directory into the Windows certificate store on both the Vault and
PVWA machines. This will facilitate an SSL connection between the Vault and the External Directory. References: Configure the Vault for LDAP, Configure LDAPS
in CyberArk. What certificate I need to use?

NEW QUESTION 78
To change the safe where recordings are kept for a specific platform, which setting must you update in the platform configuration?

A. SessionRecorderSafe Most Voted
B. SessionSafe
C. RecordingsPath
D. RecordingLocation

Answer: A

Explanation: 
 To change the safe where recordings are kept for a specific platform, you must update the SessionRecorderSafe setting in the platform configuration. This setting
specifies the name of the safe where the Privileged Session Manager (PSM) recordings will be stored. After updating the SessionRecorderSafe setting, you need
to restart the PSM service or wait for the new settings to be applied, which typically takes about 10 minutes. Once the new settings are in effect, any new PSM
sessions initiated will have their recordings stored in the newly specified safe1.
References:
? CyberArk Docs - How to Create/Change/Configure PSM Recording Safes

NEW QUESTION 80
What is the name of the Platform parameters that controls how long a password will stay valid when One Time Passwords are enabled via the Master Policy?

A. Min Validity Period
B. Interval

Passing Certification Exams Made Easy visit - https://www.2PassEasy.com



Welcome to download the Newest 2passeasy PAM-DEF dumps
https://www.2passeasy.com/dumps/PAM-DEF/ (239 New Questions)

C. Immediate Interval
D. Timeout

Answer: A

Explanation: 
 The name of the Platform parameter that controls how long a password will stay valid when One Time Passwords are enabled via the Master Policy is Min Validity
Period. This parameter defines the number of minutes to wait from the last retrieval of the account until it is replaced. This gives the user a minimum period to be
able to use the password before it is changed by the CPM. The Min Validity Period parameter can be configured in the Platform Management settings for each
platform that supports One Time Passwords. The default value is 60 minutes, but it can be modified according to the organization’s security policy1. The Min
Validity Period parameter is also used to release exclusive accounts automatically1. References:
? 1: Privileged Account Management, Min Validity Period subsection

NEW QUESTION 82
When on-boarding account using Accounts Feed, Which of the following is true?

A. You must specify an existing Safe where are account will be stored when it is on boarded to the Vault
B. You can specify the name of a new sale that will be created where the account will be stored when it is on-boarded to the Vault.
C. You can specify the name of a new Platform that will be created and associated with the account
D. Any account that is on boarded can be automatically reconciled regardless of the platform it is associated with.

Answer: B

Explanation: 
 When on-boarding accounts using Accounts Feed, you can either select an existing safe or create a new one to store the accounts. You can also specify the
platform, policy, and owner for each account. However, you cannot create a new platform using Accounts Feed, and not all platforms support automatic
reconciliation. References:
? Accounts Feed - CyberArk
? CyberArk University
? [Defender-PAM Sample Items Study Guide]

NEW QUESTION 84
You have been asked to create an account group and assign three accounts which belong to a cluster. When you try to create a new group, you receive an
unauthorized error; however, you are able to edit other aspects of the account properties.
Which safe permission do you need to manage account groups?

A. create folders
B. specify next account content
C. rename accounts
D. manage safe

Answer: D

Explanation: 
 To manage account groups, you need the manage safe permission, which allows you to create, update, and delete account groups in a safe. The other
permissions are not related to account groups. The create folders permission allows you to create folders in a safe. The specify next account content permission
allows you to specify the next password or SSH key for an account. The rename accounts permission allows you to rename accounts in a safe. References:
Manage account groups, Safe member permissions

NEW QUESTION 86
A Logon Account can be specified in the Master Policy.

A. TRUE
B. FALSE

Answer: B

Explanation: 
 A Logon Account cannot be specified in the Master Policy. The Master Policy is a set of rules that define the security and compliance policy of privileged accounts
in the organization, such as access workflows, password management, session monitoring, and auditing1. The Master Policy does not include any technical
settings that determine how the system manages accounts on various platforms1. A Logon Account is a technical setting that defines the account that the CPM
uses to log on to a target system and perform password management tasks, such as changing, verifying, or reconciling passwords2. A Logon Account can be
specified in the Platform Management settings, which are configured by the IT administrator for each platform2. The Platform Management settings are
independent of the Master Policy and can be customized according to the organization’s environment and security policies1. References:
? The Master Policy
? [Platform Management]

NEW QUESTION 88
What are the mandatory fields when onboarding from Pending Accounts? (Choose two.)

A. Address
B. Safe
C. Account Description
D. Platform
E. CPM

Answer: BD

Explanation: 
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 When onboarding accounts from the Pending Accounts list, the mandatory fields that must be specified are the Safe where the account will be stored and the
Platform that the account will be associated with. The Safe is crucial as it determines the secure location within the CyberArk Vault where the account’s
credentials will be kept. The Platform is essential because it defines the set of policies and behaviors that will be applied to the account, such as password rotation
and session monitoring12.
References:
? CyberArk Docs - Pending accounts1
? CyberArk Docs - Onboarding rules

NEW QUESTION 90
PSM for Windows (previously known as “RDP Proxy”) supports connections to the following target systems

A. Windows
B. UNIX
C. Oracle
D. All of the above

Answer: D

Explanation: 
 PSM for Windows supports connections to various types of target systems, including Windows, UNIX, Oracle, and others. PSM for Windows uses different
connection components to establish and manage the sessions, depending on the type and protocol of the target system. For example, PSM-RDP is used for
Windows systems, PSM-SSH and PSM-Telnet are used for UNIX systems, PSM-Toad and PSM-SQLPlus are used for Oracle databases, and so on. References:
? PSM for Windows
? Connect through Privileged Session Manager for Windows
? Supported connection components

NEW QUESTION 92
What is the maximum number of levels of authorization you can set up in Dual Control?

A. 1
B. 2
C. 3
D. 4

Answer: B

Explanation: 
 Dual Control is a feature that allows you to set up a workflow for approving access requests to sensitive accounts. You can configure up to two levels of
authorization for each account, meaning that you need up to two different authorizers to approve the request before the user can access the account. The
authorizers can be either users or groups, and they can have different approval methods, such as email, SMS, or CyberArk interface. References:
? [Defender PAM] course, Module 5: Privileged Session Management, Lesson 5.2:
Dual Control
? [Defender PAM Sample Items Study Guide], Question 31
? [CyberArk Documentation], Dual Control

NEW QUESTION 94
In the Private Ark client under the Tools menu > Administrative Tools > Users and Groups, which option do you use to update users’ Vault group memberships?

A. Update > General tab
B. Update > Authorizations tab
C. Update > Member Of tab
D. Update > Group tab

Answer: C

Explanation: 
 In the PrivateArk client, to update users’ Vault group memberships, you use the Member Of tab. After logging in as an administrative user and navigating to the
Users and Groups window, you select a user and click Update. In theMember Of tab, you can manage the user’s group memberships by adding or removing them
from groups within the Vault1.
References:
? CyberArk Docs - Manage users in PrivateArk client1

NEW QUESTION 95
What is the easiest way to duplicate an existing platform?

A. From PrivateArk, copy/paste the appropriate Policy.ini file; then rename it.
B. From the PVWA, navigate to the platforms page, select an existing platform that is similar to the new target account platform and then click Duplicate; name the
new platform.
C. From PrivateArk, copy/paste the appropriate settings in PVConfiguration.xml; then update the policyName variable.
D. From the PVWA, navigate to the platforms page, select an existing platform that is similar to the new target account platform, manually update the platform
settings and click “Save as” INSTEAD of save to duplicate and rename the platform.

Answer: B

Explanation: 
 The easiest way to duplicate an existing platform is to use the PVWA, which is the web interface that allows users to access and manage the CyberArk Defender
PAM system. The PVWA has a platforms page that displays all the platforms that are available in the system, categorized by platform types. Users can duplicate
an existing platform by selecting it, clicking the ellipsis button next to it, and then clicking Duplicate. This will create a copy of the platform with the same settings
and properties, which can be customized according to the user’s needs. Users can name the new platform and save it in the system.
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References: Manage platforms - CyberArk

NEW QUESTION 96
The Active Directory User configured for Windows Discovery needs which permission(s) or membership?

A. Member of Domain Admin Group
B. Member of LDAP Admin Group
C. Read and Write Permissions
D. Read Only Permissions

Answer: D

Explanation: 
 The Active Directory User configured for Windows Discovery requiresRead Only Permissions. This level of permission allows the user to query and discover
objects within the Active Directory without the ability to modify any objects or settings. Having read- only access is sufficient for discovery purposes, as it enables
the user to retrieve necessary information without posing a risk of unintended changes to the directory1.
References:
? Microsoft Learn: Configure discovery methods1

NEW QUESTION 101
Which of the following files must be created or configured m order to run Password Upload Utility? Select all that apply.

A. PACli.ini
B. Vault.ini
C. conf.ini
D. A comma delimited upload file

Answer: ACD

Explanation: 
 To run the Password Upload Utility, you need to create or configure the following files:
? A comma delimited upload file: This is a text file that contains the passwords and
their properties that will be uploaded to the Vault. The file must have a .csv extension and follow a specific format. The first line in the file defines the names of the
password properties as specified in the Password Vault. Every other line represents a single password object and its property values, according to the properties
specified in the first line1.
? PACli.ini: This is a configuration file that stores the parameters for the PACli, which
is a command-line interface that enables communication between the Password Upload Utility and the Vault. The PACli.ini file must be located in the same folder
as the Password Upload Utility executable file. The file must contain the following parameters: Vault, User, Password, and LogFile2.
? conf.ini: This is a configuration file that stores the parameters for the Password
Upload Utility. The conf.ini file must be located in the same folder as the Password Upload Utility executable file. The file must contain the following parameters:
InputFile, LogFile, and ErrorFile3.
You do not need to create or configure the following file to run the Password Upload Utility:
? Vault.ini: This is a configuration file that stores the parameters for the Vault server, such as the database name, port, and password. This file is not used by the
Password Upload Utility, and it is not located in the same folder as the Password Upload Utility executable file. The Vault.ini file is located in the Vault installation
folder, and it is used by the Vault service and the PrivateArk Client4. References:
? 1: Create the Password File
? 2: PACli.ini
? 3: Password Upload Utility Parameter File (conf.ini)
? 4: [CyberArk Privileged Access Security Implementation Guide], Chapter 2: Installing the Vault, Section: Configuring the Vault, Subsection: Vault.ini

NEW QUESTION 102
Secure Connect provides the following. Choose all that apply.

A. PSM connections to target devices that are not managed by CyberArk.
B. Session Recording
C. Real-time live session monitoring.
D. PSM connections from a terminal without the need to login to the PVWA

Answer: ABC

Explanation: 
 Secure Connect provides the following features:
? A. PSM connections to target devices that are not managed by CyberArk. This is true, because Secure Connect is a feature that enables users to connect to
target systems through PSM without storing the account credentials in the vault. Secure Connect allows users to provide their own credentials at the time of
connection, and these credentials are not saved or managed by CyberArk. Secure Connect can be used with any connection component that supports PSM, such
as RDP, SSH, WinSCP, etc1.
? B. Session Recording. This is true, because Secure Connect sessions are recorded by PSM and stored in the Vault, just like regular PSM sessions. The
recorded sessions can be viewed and audited by authorized users through the PVWA or the PSM web interface2.
? C. Real-time live session monitoring. This is true, because Secure Connect sessions can be monitored in real-time by authorized users through the PSM web
interface. The PSM web interface allows users to view the live session screen, send messages to the session user, pause or terminate the session, and take
control of the session if needed3.
The following feature is not provided by Secure Connect:
? D. PSM connections from a terminal without the need to login to the PVWA. This is false, because Secure Connect requires users to login to the PVWA and
initiate the connection from there. The PVWA provides the URL for the Secure Connect session, which contains the target system address and the connection
component ID. The user then needs to copy and paste the URL into a browser or a remote connection manager to launch the session1.
References:
? 1: Secure Connect
? 2: Recorded Sessions
? 3: PSM Web Interface
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NEW QUESTION 106
Which of the following are secure options for storing the contents of the Operator CD, while still allowing the contents to be accessible upon a planned Vault
restart? (Choose three.)

A. Store the CD in a physical safe and mount the CD every time Vault maintenance is performed
B. Copy the entire contents of the CD to the system Safe on the Vault
C. Copy the entire contents of the CD to a folder on the Vault Server and secure it with NTFS permissions
D. Store the server key in a Hardware Security Module (HSM) and copy the rest the keys from the CD to a folder on the Vault Server and secure it with NTFS
permissions

Answer: ABD

Explanation: 
? A. Store the CD in a physical safe and mount the CD every time Vault maintenance is performed. This option ensures that the CD is kept in a secure location
when not in use, and that the keys are available when needed. This is the default option suggested by CyberArk1.
? B. Copy the entire contents of the CD to the system Safe on the Vault. This option allows the Vault to access the keys from the system Safe, which is a special
Safe that stores the Vault configuration files and keys. The system Safe is encrypted and protected by the Vault, and can only be accessed by authorized users2.
? D. Store the server key in a Hardware Security Module (HSM) and copy the rest the keys from the CD to a folder on the Vault Server and secure it with NTFS
permissions. This option provides an additional layer of security for the server key, which is the most critical key for the Vault. An HSM is a physical device that
stores and manages cryptographic keys in a tamper-resistant and isolated environment. The Vault can integrate with an HSM to store and retrieve the server key3.
The rest of the keys can be stored in a folder on the Vault Server and secured with NTFS permissions, which restrict access to authorized users and groups.
The following option is not secure and should be avoided:
? C. Copy the entire contents of the CD to a folder on the Vault Server and secure it with NTFS permissions. This option exposes the keys to potential risks, such
as unauthorized access, data corruption, or deletion. NTFS permissions are not sufficient to protect the keys from malicious or accidental actions. Moreover, this
option does not comply with the CyberArk best practices, which recommend to store the keys on a removable media or an HSM

NEW QUESTION 110
It is possible to restrict the time of day, or day of week that a [b]reconcile[/b] process can occur

A. TRUE
B. FALSE

Answer: A

Explanation: 
 It is possible to restrict the time of day, or day of week that a reconcile process can occur by using the Reconcile Safe option in thePlatform Management section
of thePrivateArk Client. This option allows the administrator to define the reconcile schedule for each platform, which specifies when the reconcile process can run
and how often it should be performed. The reconcile schedule can be set to run daily, weekly, monthly, or on specific days and times. By restricting the reconcile
process, the administrator can reduce the risk of unauthorized access to the accounts and improve the performance of the system. References:
? [Defender PAM Course], Module 5: Reconcile and Rotate, Lesson 1: Reconcile and Rotate Overview, Slide 9: Reconcile Safe
? [Defender PAM Study Guide], Section 5.1: Reconcile and Rotate Overview, Page 24: Reconcile Safe
? [CyberArk Documentation], Privileged Access Security Implementation Guide, Chapter 5: Configure the Vault, Section 5.4: Configure Platforms, Subsection
5.4.2: Reconcile Safe

NEW QUESTION 114
Your organization has a requirement to allow users to “check out passwords” and connect to targets with the same account through the PSM.
What needs to be configured in the Master policy to ensure this will happen?

A. Enforce check-in/check-out exclusive access = active; Require privileged session monitoring and isolation = active
B. Enforce check-in/check-out exclusive access = inactive; Require privileged session monitoring and isolation = inactive
C. Enforce check-in/check-out exclusive access = inactive; Record and save session activity = active
D. Enforce check-in/check-out exclusive access = active; Record and save session activity= inactive

Answer: A

Explanation: 
 The Master Policy in CyberArk allows organizations to permit users to check out a ‘one-time’ password and lock it so that no other users can retrieve it at the
same time. After the user has used the password, they check the password back into the Vault, ensuring exclusive usage of the privileged account. This is
achieved by setting the ‘Enforce check-in/check-out exclusive access’ to active. Additionally, to ensure that all sessions are monitored and isolated, the ‘Require
privileged session monitoring and isolation’ must also be set to active. This combination of settings guarantees both the exclusive access to
privileged accounts and the necessary session monitoring for security and compliance purposes1.
References:
? CyberArk’s official documentation on Account check-out and check-in1.
? The Master Policy overview provided by CyberArk2.

NEW QUESTION 119
VAULT authorizations may be granted to .

A. Vault Users
B. Vault Groups
C. LDAP Users
D. LDAP Groups

Answer: AC

Explanation: 
 Vault Authorizations
• Can be assigned only to users (not groups).
• Cannot be inherited via group membership.
• Defined only via the Private Ark Client. Safe Auth
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• Assigned to users and/or groups.
• Can be inherited via group membership.
• Can be defined in the Private Ark Client or PVWA

NEW QUESTION 122
What does the Export Vault Data (EVD) utility do?

A. exports data from the Vault to TXT or CSV files, or to MSSQL databases
B. generates a backup file that can be used as a cold backup
C. exports all passwords and imports them into another instance of CyberArk
D. keeps two active vaults in sync

Answer: A

Explanation: 
 The Export Vault Data (EVD) utility is used to export data from the CyberArk Vault to TXT or CSV files, or to MSSQL databases. This utility enables the creation of
reports such as a list of Safes or incoming requests by exporting data from the Vault. Each report is saved in a separate file, which can then be imported into third-
party applications or databases for further analysis or reporting purposes12.
References:
? CyberArk Docs - Export Vault Data (EVD) utility1
? CyberArk Docs - Export data to files

NEW QUESTION 127
Where can you check that the LDAP binding is using TCP/636?

A. in Active Directory under "Users OU" => "User Properties" => "External Bindings" => "Port"
B. in PVWA, under "LDAP Integration" => "LDAP" => "Directories" => "" => "Hosts" => "Host"
C. in PrivateArk Client, under "Tools" => "Administrative Tools" => "Directory Mapping" => ""
D. From the PVWA, connect to the domain controller using Test-NetConnection on Port 636.

Answer: D

Explanation: 
 To check that the LDAP binding is using TCP/636, you can use the Test- NetConnection cmdlet from the PVWA to connect to the domain controller on Port 636.
This method allows you to verify that the LDAP service is listening on the secure port and that the connection can be established using SSL/TLS, which is typically
associated with port 6361.
References:
? CyberArk Docs - LDAP Integration2
? CyberArk Knowledge Article - How to test outgoing LDAP external directory connectivity to the vault

NEW QUESTION 131
Which of the following components can be used to create a tape backup of the Vault?

A. Disaster Recovery
B. Distributed Vaults
C. Replicate
D. High Availability

Answer: C

Explanation: 
 The Replicate component can be used to create a tape backup of the Vault. The Replicate component is a utility that exports the encrypted contents of the Safes
and the Vault metadata to a computer outside the Vault environment. A global backup system can then access the replicated files and copy them to a tape or any
other backup media. The Replicate component is part of the CyberArk Backup Process, which provides a secure and easy method of backing up and restoring the
Vault data12. The other components are not related to the tape backup of the Vault. Disaster Recovery is a feature that enables the Vault to recover from a
catastrophic failure by using a standby Vault server3. Distributed Vaults is a feature that enables the Vault to synchronize data with other Vaults in different
locations4. High Availability is a feature that enables the Vault to maintain continuous operation by using a primary and a secondary Vault server. References:
? Use the CyberArk Backup Process - CyberArk, section “Use the CyberArk Backup
Process”
? Install the Vault Backup Utility - CyberArk, section “Backup utilities”
? Disaster Recovery - CyberArk, section “Disaster Recovery”
? Distributed Vaults - CyberArk, section “Distributed Vaults”
? [High Availability - CyberArk], section “High Availability”

NEW QUESTION 133
When onboarding multiple accounts from the Pending Accounts list, which associated setting must be the same across the selected accounts?

A. Platform
B. Connection Component
C. CPM
D. Vault

Answer: A

Explanation: 
 When onboarding multiple accounts from the Pending Accounts list, all the selected accounts must be associated with the same platform. This is necessary
because the platform setting determines how the accounts will be managed within CyberArk, including the policies and behaviors that apply to those accounts. If
an account contains dependencies, those dependencies are automatically onboarded with the account. This ensures that all accounts and their dependencies are
managed consistently and according to the correct policies1.
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References:
? CyberArk’s official documentation on Onboarding Accounts and SSH Keys1.

NEW QUESTION 138
It is possible to control the hours of the day during which a user may log into the vault.

A. TRUE
B. FALSE

Answer: A

Explanation: 
 It is possible to control the hours of the day during which a user may log into the vault by using the Time Restrictions feature. This feature allows administrators to
define the days and times that users can access the vault. Users who try to log in outside the permitted hours will be denied access and receive a message
informing them of the restriction. Time restrictions can be applied to individual users or groups of users. References:
? [Defender PAM eLearning Course], Module 3: Safes and Permissions, Lesson 3.3:
User Management, Slide 7: Time Restrictions
? [Defender PAM Sample Items Study Guide], Question 2: Time Restrictions
? [CyberArk Documentation Portal], CyberArk Privileged Access Security Implementation Guide, Chapter 4: Managing Users and Groups, Section: Time
Restrictions

NEW QUESTION 142
In a default CyberArk installation, which group must a user be a member of to view the “reports” page in PVWA?

A. PVWAMonitor
B. ReportUsers
C. PVWAReports
D. Operators

Answer: A

Explanation: 
 In a default CyberArk installation, to view the “reports” page in the PVWA (Privileged Web Access), a user must be a member of the PVWAMonitor group1. This
group is specified in the ManageReportsGroup parameter in the Reports section of the Web Access Options in the System Configuration page. Being a member of
this group grants the user the necessary permissions to generate and view reports within the PVWA. References:
? CyberArk’s official documentation on Reports in PVWA outlines the requirement
for users to belong to the PVWAMonitor group to access the reports page and generate reports1.

NEW QUESTION 147
Can the 'Connect' button be used to initiate an SSH connection, as root, to a Unix system when SSH access for root is denied?

A. Yes, when using the connect button, CyberArk uses the PMTerminal.exe process which bypasses the root SSH restriction.
B. Yes, only if a logon account is associated with the root account and the user connects through the PSM-SSH connection component.
C. Yes, if a logon account is associated with the root account.
D. No, it is not possible.

Answer: B

Explanation: 
 The ‘Connect’ button is a feature of the PVWA that allows users to initiate a privileged session to a target system through PSM without revealing the account
credentials. The ‘Connect’ button can be used to initiate an SSH connection, as root, to a Unix system when SSH access for root is denied, but only if a logon
account is associated with the root account and the user connects through the PSM-SSH connection component. A logon account is a linked account that contains
the password required to log on to a remote machine in order to perform a task using the regular account. A common use case for using a logon account is
managing root accounts on a Unix system. The best practice for Unix systems is to disallow the root user from logging in using SSH. However, SSH is what the
PSM uses to sign in to a system to manage the password. To manage the root password without violating this practice, the PSM establishes the session with a
non-root account and then SUs to root (the target account). This is done using a linked account called a logon account. The PSM-SSH connection component is a
predefined connection component that enables users to connect to Unix systems through PSM using SSH. The PSM-SSH connection component supports the use
of logon accounts to access root accounts on Unix systems1.
The other options are not correct, because:
? A. Yes, when using the connect button, CyberArk uses the PMTerminal.exe process which bypasses the root SSH restriction. This is not correct, because
PMTerminal.exe is a process that is used by the PSM-RDP connection component, not the PSM-SSH connection component. PMTerminal.exe is a terminal
emulator that enables users to connect to Windows systems through PSM using RDP. PMTerminal.exe does not bypass the root SSH restriction, but rather uses
the credentials stored in the Vault to authenticate to the target system2.
? C. Yes, if a logon account is associated with the root account. This is not correct, because a logon account alone is not sufficient to initiate an SSH connection,
as root, to a Unix system when SSH access for root is denied. The user also needs to connect through the PSM-SSH connection component, which supports the
use of logon accounts to access root accounts on Unix systems1.
? D. No, it is not possible. This is not correct, because it is possible to initiate an SSH connection, as root, to a Unix system when SSH access for root is denied, as
explained in option B.
References:
? 1: Logon Accounts for SSH and Telnet Connections
? 2: Connect through PSM for SSH

NEW QUESTION 148
DRAG DROP
Match the log file name with the CyberArk Component that generates the log.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
References:
? Log Files
? [Defender PAM Sample Items Study Guide], Question 46, page 16

NEW QUESTION 153
In addition to add accounts and update account contents, which additional permission on the safe is required to add a single account?

A. Upload Accounts Properties
B. Rename Accounts
C. Update Account Properties
D. Manage Safe

Answer: C

Explanation: 
 In addition to the permissions to add accounts and update account contents, the permission to Update Account Properties is required to add a single account to a
safe in CyberArk. This permission allows the user to modify the properties of an account, which is a necessary step when adding a new account to ensure that all
relevant details and configurations are correctly set1. References: The information provided is based on general knowledge of CyberArk PAM best practices and
the permissions required for account management as outlined in CyberArk’s official documentation

NEW QUESTION 157
Which CyberArk group does a user need to be part of to view recordings or live monitor sessions?

A. Auditors
B. Vault Admin
C. DR Users
D. Operators

Answer: A

Explanation: 
 To view recordings or live monitor sessions, users must be part of the Auditors group or have the appropriate permissions in the relevant Account Safes and
Recording Safes12. The other groups do not have the necessary permissions to access the recordings or monitor the sessions by default. References: Monitor
Active Sessions, Active Session Monitoring

NEW QUESTION 159
Which change could CyberArk make to the REST API that could cause existing scripts to fail?

A. adding optional parameters in the request
B. adding additional REST methods
C. removing parameters
D. returning additional values in the response

Answer: C

Explanation: 
 Changes to the REST API that could cause existing scripts to fail include removing parameters. When parameters are removed from an API, scripts that rely on
those parameters being present may no longer function correctly because they expect certain data to be available. This can lead to errors or unexpected behavior
in the scripts that use the API1.
References:
? CyberArk Docs: REST APIs1

NEW QUESTION 160
Which item is an option for PSM recording customization?

A. Windows events text recorder with automatic play-back
B. Windows events text recorder and universal keystrokes recording simultaneously
C. Universal keystrokes text recorder with windows events text recorder disabled
D. Custom audio recording for windows events

Answer: C
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Explanation: 
 For PSM recording customization, one of the options is to use the Universal keystrokes text recorder with theWindows events text recorder disabled. This
configuration allows for the recording of all keystrokes that are typed during privileged sessions on all supported connections. However, it is important to note that
Universal keystroke recording andWindows events recordings cannot be configured for the same PSM-RDP connection. By default, Windows events text recording
is enabled for PSM-RDP connections, so to enable universal keystrokes text recording, the Windows events text recording must first be disabled1.
References:
? CyberArk’s official documentation on configuring recordings and audits in PSM, which includes details on how to customize text recorders and the limitations of
configuring multiple recorders for the same connection1

NEW QUESTION 165
Which report could show all accounts that are past their expiration dates?

A. Privileged Account Compliance Status report
B. Activity log
C. Privileged Account Inventory report
D. Application Inventory report

Answer: A

Explanation: 
 The Privileged Account Compliance Status report shows the compliance status of all privileged accounts in the Vault, based on the expiration date and password
change policy. This report can help identify accounts that are past their expiration dates and need to be updated or removed. References:
? [Defender PAM Sample Items Study Guide], page 18, question 90
? [CyberArk Privileged Access Security Documentation], version 12.3, Reports Guide, page 27, Privileged Account Compliance Status report

NEW QUESTION 169
You want to create a new onboarding rule. Where do you accomplish this?

A. In PVWA, click Reports > Unmanaged Accounts > Rules
B. In PVWA, click Options > Platform Management > Onboarding Rules
C. In PrivateArk, click Tools > Onboarding Rules
D. In PVWA, click Accounts > Onboarding Rules

Answer: D

Explanation: 
 To create a new onboarding rule, you accomplish this in the Privileged Vault Web Access (PVWA) by navigating to Accounts > Onboarding Rules. Once there,
you can click on Create rule to start the New onboarding rule wizard and proceed with the configuration of the rule. This process allows you to set up rules that
automatically onboard newly discovered accounts, minimizing manual effort and reducing the chance of human error1.
References:
? CyberArk Docs - Onboarding rules

NEW QUESTION 171
Via Password Vault Web Access (PVWA), a user initiates a PSM connection to the target Linux machine using RemoteApp. When the client’s machine makes an
RDP connection to the PSM server, which user will be utilized?

A. Credentials stored in the Vault for the target machine
B. Shadowuser
C. PSMConnect
D. PSMAdminConnect

Answer: C

Explanation: 
 According to the CyberArk Defender PAM documentation1, when a user initiates a PSM connection to the target Linux machine using RemoteApp via PVWA, the
client’s machine makes an RDP connection to the PSM server using the PSMConnect user. The PSMConnect user is a local or domain user that starts PSM
sessions on the PSM machine. The PSMConnect user has limited permissions and access rights on the PSM server, and its credentials are managed by the CPM.
The PSMConnect user retrieves the credentials of the target account from the vault and uses them to establish a secure connection to the target machine. The
user can then interact with the target machine through the PSM session, while the PSM server records and audits the session activity.

NEW QUESTION 172
Refer to the exhibit.
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Why is user "EMEALevel2Support" unable to change the password for user "Operator"?

A. EMEALevel2Support’s hierarchy level is not the same or higher than Operator.
B. EMEALevel2Support does not have the "Manage Directory Mapping" role.
C. Operator can only be reset by the Master user.
D. EMEALevel2Support does not have rights to reset passwords for other users.

Answer: D

Explanation: 
 The image description indicates that “EMEALevel2Support” has the following rights: Add/Update Users, Manage Server File Categories, Manage Directory
Mapping, Backup All Files, Restore All Files. Since there is no mention of the right to reset passwords for other users, this suggests that “EMEALevel2Support”
lacks the necessary permission to change the password for “Operator”.

NEW QUESTION 173
Users who have the 'Access Safe without confirmation' safe permission on a safe where accounts are configured for Dual control, still need to request approval to
use the account.

A. TRUE
B. FALSE

Answer: B

Explanation: 
Users who have the ‘Access Safe without confirmation’ safe permission on a safe where accounts are configured for Dual control, do not need to request
approval to use the account. The ‘Access Safe without confirmation’ safe permission is a special permission that allows a user to bypass the Dual control
mechanism and access the accounts in the safe without requiring confirmation from other authorized users. This permission can be useful for emergency
situations or trusted users who need immediate access to the accounts. However, this permission also increases the risk of unauthorized or malicious access, so it
should be granted with caution and monitored closely1.
References:
? 1: Access without confirmation

NEW QUESTION 177
A recently-hired colleague onboarded five new Local Accounts that are used for five standalone Windows Servers. After attempting to connect to the servers from
PVWA, the colleague noticed that the "Connect" button was greyed out for all five new accounts.
What can you do to help your colleague resolve this issue? (Choose two.)

A. Verify that the address field is populated with an IP or FQDN of each server.
B. Verify that the correct PSM connection component appears within account platform settings.
C. Verify that the address field is blank and that the correct PSM connection component appears within account platform settings.
D. Notify the Windows Team that created the new accounts that the CyberArk PAM solution is not designed to manage local accounts on Windows Servers.
E. Verify that the "Disable automatic management for this account" setting for each account is not enabled.

Answer: ABE

Explanation: 
? Verify Server Address: Ensure that the address field is populated with the correct IP or FQDN for each server (Option A).
? Check PSM Settings: Confirm that the correct PSM connection component is specified within the account platform settings (Option B).
? Automatic Management: Check if the “Disable automatic management for this account” setting is not enabled (Option E).
These steps should help in troubleshooting the connection issue in the CyberArk Privileged Access Management (PAM) solution.
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NEW QUESTION 181
You are troubleshooting a PVWA slow response. Which log files should you analyze first? (Choose two.)

A. ITALog.log
B. web.config
C. CyberArk.WebApplication.log
D. CyberArk.WebConsole.log

Answer: CD

Explanation: 
 When troubleshooting a slow response in the Privileged Vault Web Access (PVWA), the first log files to analyze are the CyberArk.WebApplication.log and
CyberArk.WebConsole.log. These logs contain detailed information about the activities carried out by the PVWA and can help identify any problems that may
occur. The log files are created by the PVWA and stored on the Web server in the location specified in the LogFolder parameter in the web.config file1. By
examining these logs, you can track business flows and troubleshoot failures without having to enable debug mode. References:
? CyberArk Docs - PVWA Logging1

NEW QUESTION 184
Within the Vault each password is encrypted by:

A. the server key
B. the recovery public key
C. the recovery private key
D. its own unique key

Answer: D

Explanation: 
 According to the web search results, within the Vault each password is encrypted by its own unique key. This key is generated by the Vault when the password is
added to the Vault and is stored in the Vault’s database. The password key is encrypted by the safe key, which is the key of the safe that contains the password.
The safe key is encrypted by the server key, which is the key that opens the Vault. The server key is encrypted by the public recovery key, which is part of the
asymmetric recovery key that enables the Master User to log on to the Vault in case of a disaster. This layered encryption scheme ensures that each password is
protected by multiple keys and that no single key can compromise the security of the Vault

NEW QUESTION 186
To manage automated onboarding rules, a CyberArk user must be a member of which
group?

A. Vault Admins
B. CPM User
C. Auditors
D. Administrators

Answer: A

Explanation: 
 To manage automated onboarding rules in CyberArk, a user must be a member of the Vault Admins group. This group has the necessary permissions to create
and manage predefined rules that automatically onboard newly discovered accounts, which helps minimize the time it takes to onboard and securely manage
accounts, reduces the time spent on reviewing pending accounts, and prevents human errors that may occur during manual onboarding1.
References:
? CyberArk’s official documentation on onboarding rules provides detailed information on the groups required to manage these rules, including the Vault Admins
group1.

NEW QUESTION 191
DRAG DROP
ADR Vault became active due to a failure of the primary Vault. Service on the primary Vault has now been restored. Arrange the steps to return the DR vault to its
normal standby mode in the correct sequence.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
? Shut down the PrivateArk Server Service on the DR Vault.
? In the PADR.ini file, set Failover Mode = No and remove the last two lines.
? Start the PrivateArk Disaster Recovery Service.
Comprehensive Explanation: When the primary Vault service has been restored and you need to return the DR Vault to its normal standby mode, the steps are as
follows:
? Shut down the PrivateArk Server Service on the DR Vault to stop the Vault from being active.
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? Modify the PADR.ini file by setting Failover Mode to No and removing the last two lines that were added during the failover process. This reconfigures the DR
Vault to standby mode.
? Start the PrivateArk Disaster Recovery Service to complete the transition back to standby mode1.
References:
? CyberArk Docs - Initiate a DR Failback to the Production Vault1

NEW QUESTION 192
According to CyberArk, which issues most commonly cause installed components to display as disconnected in the System Health Dashboard? (Choose two.)

A. network instabilities/outages
B. vault license expiry
C. credential de-sync
D. browser compatibility issues
E. installed location file corruption

Answer: AC

Explanation: 
 The System Health Dashboard in CyberArk provides a visual representation of the health status of different CyberArk components. When components are
displayed as disconnected, the most common issues are network instabilities/outages and credential de- sync. Network issues can disrupt the connectivity
between components and the Vault, while credential de-sync indicates that a component is no longer able to authenticate to the Vault due to synchronization
problems with the credentials12. References:
? CyberArk Docs: Monitor system health1
? CyberArk Docs: System Health Dashboard details

NEW QUESTION 195
Your customer, ACME Corp, wants to store the Safes Data in Drive D instead of Drive C. Which file should you edit?

A. TSparm.ini
B. Vault.ini
C. DBparm.ini
D. user.ini

Answer: A

Explanation: 
 To store the Safes Data in a different drive, such as moving from Drive C to Drive D, you need to edit the TSparm.ini file. This file contains various parameters that
configure the behavior of the Vault, including the location of the Safes Data. By editing the SafesDirectory parameter in theTSparm.ini file, you can specify a new
path for the Safes Data, effectively changing the storage location to the desired drive1.
References:
? CyberArk’s official documentation on managing files and documents, which includes information on how to store files in different locations within the Vault2.
? Knowledge articles on how to move the PSMRecordings safe or other Vault data to a different drive, which provide step-by-step instructions and mention the
TSparm.ini file1

NEW QUESTION 200
By default, members of which built-in groups will be able to view and configure Automatic Remediation and Session Analysis and Response in the PVWA?

A. Vault Admins
B. Security Admins
C. Security Operators
D. Auditors

Answer: B

Explanation: 
 Security Admins are the built-in group that can view and configure Automatic Remediation and Session Analysis and Response in the PVWA. These features are
part of the Privileged Threat Analytics (PTA) module, which is designed to detect and respond to anomalous activities and risky behaviors in the privileged
environment. Security Admins have the permissions to access the PTA settings and configure the policies and actions for Automatic Remediation and Session
Analysis and Response. References:
? Defender PAM Sample Items Study Guide, page 18, question 49
? Privileged Threat Analytics Implementation Guide, page 9, section “Security Admins”

NEW QUESTION 201
Which Master Policy Setting must be active in order to have an account checked-out by one user for a pre-determined amount of time?

A. Require dual control password access Approval
B. Enforce check-in/check-out exclusive access
C. Enforce one-time password access
D. Enforce check-in/check-out exclusive access & enforce one-time password access

Answer: B

Explanation: 
 According to the CyberArk Defender PAM documentation, the Master Policy setting that must be active in order to have an account checked-out by one user for a
pre- determined amount of time is Enforce check-in/check-out exclusive access. This setting enables organizations to permit users to check out a ‘one-time’
password and lock it so that no other users can retrieve it at the same time. After the user has used the password, the user checks the password back into the
Vault. This ensures exclusive usage of the privileged account, enabling full control and tracking for the password. The duration of the check-out period can be
configured in the platform settings for each account. References:
? Account check-out and check-in - CyberArk
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? Master Policy - CyberArk

NEW QUESTION 203
CyberArk recommends implementing object level access control on all Safes.

A. True
B. False

Answer: B

Explanation: 
 CyberArk does not recommend implementing object level access control on all Safes. According to the CyberArk documentation1, enabling object level access
control impacts Vault performance. Therefore, it should be used only when necessary and with caution. Object level access control is useful when you need to give
granular permissions to specific passwords or files in a Safe, regardless of the Safe level member authorizations. For example, you can use it to grant access to an
external vendor or technician for a specific password only, without exposing any other passwords or files in the Safe. However, if you do not need this level of
granularity, you can use the regular Safe member authorizations to control user access to the Safe and its contents.

NEW QUESTION 206
dbparm.ini is the main configuration file for the Vault.

A. True
B. False

Answer: B

Explanation: 
 dbparm.ini is not the main configuration file for the Vault. It is one of the several configuration files that control the initial settings and method of operation of the
Server. The main configuration file for the Vault is DBParm.ini, which contains the general parameters of the database, such as the Vault name, the Vault IP
address, the Vault port, the encryption algorithm, the log retention, and the debug mode1. References:
? DBParm.ini - CyberArk, section “Main parameters”

NEW QUESTION 209
The Password upload utility can be used to create safes.

A. TRUE
B. FALSE

Answer: A

Explanation: 
 The Password Upload utility can be used to create safes, as well as password objects, folders, and platforms. The Password Upload utility works with the
CyberArk Password Vault to create password objects from a passwords list and store them in the Vault. This enables you to upload large numbers of passwords
automatically and makes the Vault implementation process quicker and more automatic. The Password Upload utility initiates the Vault environment required to
store passwords in the safe and start working with them. This includes creating new safes, adding the CPM user as a safe owner, and sharing the safe with the
Password Vault Web Access1. References:
? 1: Password Upload Utility

NEW QUESTION 211
Which command generates a full backup of the Vault?

A. PAReplicate.exe Vault.ini /LogonFromFile user.ini /FullBackup
B. PAPreBackup.exe C:\PrivateArk\Server\Conf\Vault.ini Backup/Asdf1234 /full
C. PARestore.exe PADR ini /LogonFromFile vault.ini /FullBackup
D. CAVaultManager.exe RecoverBackupFiles /BackupPoolName BkpSvr1

Answer: A

Explanation: 
 The command PAReplicate.exe with the /FullBackup option is used to generate a full backup of the CyberArk Vault. This command requires the Vault
configuration file (typically Vault.ini) and a credential file (specified with /LogonFromFile) that contains the user’s encrypted logon credentials. The /FullBackup
option indicates that a full backup of the Vault is to be performed, as opposed to an incremental backup1. References:
? CyberArk Docs: Install the Vault Backup Utility2
? CyberArk Knowledge Article: PAReplicate Configuration and Usage

NEW QUESTION 213
Time of day or day of week restrictions on when password verifications can occur configured in .

A. The Master Policy
B. The Platform settings
C. The Safe settings
D. The Account Details

Answer: C

Explanation: 
 Time of day or day of week restrictions on when password verifications can occur are configured in the Safe settings. This is a security feature that prevents Safes
from being opened except at certain times (e.g., 8 a.m. to 5 p.m.). If a user tries to enter at a time that has not been designated for access, they will receive a
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message that informs them that the Safe is unavailable. References: Advanced Safe Management

NEW QUESTION 218
How much disk space do you need on the server for a PAReplicate?

A. 500 GB
B. 1 TB
C. same as disk size on Satellite Vault
D. same as disk size on Primary Vault

Answer: D

Explanation: 
 The PAReplicate utility exports the Safe files from the CyberArk Vault to a computer on the local network where the Backup utility has been installed. The Safes
are copied in a similar format and structure to the one in the Server. Therefore, the disk space required on the server for a PAReplicate is the same as the disk
size on the Primary Vault1. References: Use the CyberArk Backup Process

NEW QUESTION 223
Assuming a safe has been configured to be accessible during certain hours of the day, a Vault Admin may still access that safe outside of those hours.

A. TRUE
B. FALSE

Answer: A

Explanation: 
 A Vault Admin may still access a safe outside of the hours that it has been configured to be accessible, as long as he has the Bypass Safe Time Restrictions
authorization on the Vault. The Bypass Safe Time Restrictions authorization enables a user to access any safe in the Vault, regardless of the time restrictions that
are defined for that safe. This authorization is useful for emergency situations or maintenance tasks that require access to safes outside of the normal working
hours. By default, the Vault Admins group has this authorization, as well as other administrative authorizations on the Vault1. References:
? 1: Vault Member Authorizations

NEW QUESTION 228
Users are unable to launch Web Type Connection components from the PSM server. Your manager asked you to open the case with CyberArk Support.
Which logs will help the CyberArk Support Team debug the issue? (Choose three.)

A. PSMConsole.log
B. PSMDebug.log
C. PSMTrace.log
D. <Session_ID>.Component.log
E. PMconsole.log
F. ITAlog.log

Answer: ACD

Explanation: 
 When users are unable to launch Web Type Connection components from the PSM server, the CyberArk Support Team will require specific logs to debug the
issue. The logs that are typically helpful in such cases include:
? PSMConsole.log: This log file contains informational messages and errors related to the PSM function, which can help identify issues with the PSM server’s
operation1.
? PSMTrace.log: This log file includes errors and trace messages, which can provide detailed insights into the issues occurring during the PSM server’s
processes1.
? <Session_ID>.Component.log: This log file contains errors and trace messages related to the connection component, which can be crucial for troubleshooting
issues with launching Web Type Connection components1.
These logs can provide the necessary information to understand the problem and assist the support team in resolving the issue effectively.
References:
? CyberArk’s official documentation on PSM for Web Troubleshooting, which outlines the types of logs available and their purposes in the troubleshooting
process1.
? Additional resources on managing and interpreting PSM logs, which provide guidance on using logs for diagnosing and resolving issues with the PSM server2

NEW QUESTION 230
When Dual Control is enabled a user must first submit a request in the Password Vault Web Access (PVWA) and receive approval before being able to launch a
secure connection via PSM for Windows (previously known as RDP Proxy).

A. True
B. False, a user can submit the request after the connection has already been initiated via the PSM for Windows

Answer: A

Explanation: 
 According to the CyberArk Defender PAM documentation1, when Dual Control is enabled, a user must first submit a request in the Password Vault Web Access
(PVWA) and receive approval before being able to launch a secure connection via PSM for Windows (previously known as RDP Proxy). This is a security feature
that ensures that passwords can only be retrieved after permission or ‘confirmation’ has been granted from an authorized Safe Owner(s). The user must specify
the reason for accessing the account, whether they will access it once or multiple times, and the time period during which they will access it. The request is then
sent to the authorized Safe Owners, who can either confirm or reject it. The number of confirmations required is defined in the Master Policy. Only after the user
receives the required confirmations, they can activate the request and access the account through PSM for Windows. This way, Dual Control adds an additional
measure of protection and accountability for accessing sensitive accounts.
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NEW QUESTION 231
You receive this error:
“Error in changepass to user domain\user on domain server(\domain.(winRc=5) Access is denied.”
Which root cause should you investigate?

A. The account does not have sufficient permissions to change its own password.
B. The domain controller is unreachable.
C. The password has been changed recently and minimum password age is preventing the change.
D. The CPM service is disabled and will need to be restarted.

Answer: A

Explanation: 
 The error message “Error in changepass to user domain\user on domain server(\domain.(winRc=5) Access is denied” suggests that the account attempting to
change the password does not have the necessary permissions to do so. This could be due to several reasons, such as the account not being part of the
appropriate group with password change privileges, or specific restrictions set on the account that prevent password changes. It’s important to verify the
account’s permissions and ensure it has the ability to change its own password within the domain.
References: The conclusion is based on common issues encountered in CyberArk’s Privileged Access Management (PAM) when managing account passwords
and the associated error codes. The CyberArk documentation and community discussions provide insights into troubleshooting such errors, where insufficient
permissions are a frequent cause

NEW QUESTION 236
In accordance with best practice, SSH access is denied for root accounts on UNIX/LINUX system. What is the BEST way to allow CPM to manage root accounts.

A. Create a privileged account on the target serve
B. Allow this account the ability to SSH directly from the CPM machin
C. Configure this account as the Reconcile account of the target server’s root account.
D. Create a non-privileged account on the target serve
E. Allow this account the ability to SSH directly from the CPM machin
F. Configure this account as the Logon account of the target server’s root account.
G. Configure the Unix system to allow SSH logins.
H. Configure the CPM to allow SSH logins.

Answer: B

Explanation: 
 https://docs.cyberark.com/Product- Doc/OnlineHelp/PAS/Latest/en/Content/PASIMP/Using-Logon-Accounts-for-SSH-and- Telnet-
Connections.htm?Highlight=logon%20account

NEW QUESTION 241
What is required to manage loosely connected devices?

A. PSM for SSH
B. EPM
C. PSM
D. PTA

Answer: B

Explanation: 
 To manage loosely connected devices, which are not always connected to the network, CyberArk uses the Endpoint Privilege Manager (EPM). EPM is capable of
rotating credentials of accounts on Windows and macOS devices that are loosely connected to the enterprise network. It operates over the internet and can
communicate with the corporate PVWA to retrieve the new password and change it on the device1. References: The information provided is based on general
knowledge of CyberArk PAM
best practices and the management of loosely connected devices as outlined in CyberArk’s official documentation1.

NEW QUESTION 243
What is the purpose of the password change process?

A. To test that CyberArk is storing accurate credentials for accounts
B. To change the password of an account according to organizationally defined password rules
C. To allow CyberArk to manage unknown or lost credentials
D. To generate a new complex password

Answer: B

Explanation: 
 The purpose of the password change process is to change the password of an account according to organizationally defined password rules. The password
change process is a feature of CyberArk that enables the Central Policy Manager (CPM) to manage the passwords of privileged accounts that are stored in the
Vault. The CPM can change the passwords automatically or manually, based on predefined policies, schedules, or user requests. The password change process
ensures that the passwords are secure, compliant, and synchronized with the target systems and the Vault. The password change process also supports different
types of accounts, such as one-time passwords, exclusive accounts, and dual accounts1.
The other options are not the main purpose of the password change process, although they may be related to some aspects of it. The password change process
does not test that CyberArk is storing accurate credentials for accounts, although it may verify the password validity before changing it. The password change
process does not allow CyberArk to manage unknown or lost credentials, although it may reconcile the passwords if they are out of sync with the target systems.
The password change process does not generate a new complex password, although it may use a random password generation mechanism to create a new
password that meets the password policy requirements. References:
? Change Passwords - CyberArk, section “Change Passwords”
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NEW QUESTION 244
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